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Transportコントロール 

Pyramixの機能には、再生/リバース再生を含む様々なTransportコントロールも特徴となっており、倍速（2，4，

16）設定や、ショートカット・キーへの割り当てなどのカスタマイズが行えます。（ショートカットの編集については、

17章を参照してください。） 
  
  

ナビゲーション 

Pyramixには、プロジェクトをナビゲートするための多くのコマンドや方法があります。 
  
  

タイム・スケール・バー 

メインのTimeCodeスケール・バー 

プロジェクトの編集パネルの上段には、水平方向にTimecode情報を表示するエリアがあります。ここが、メインの

TimeCodeスケール・バーとなります。Timeスケール・バーの左端（トラック･ヘッダー表示の上）には、現在表示し

ているタイムラインの範囲（ズームのスケール）が示されます。 
  

プロジェクトのEditパネル内でPlayカーソルを移動する最も簡単な方法は、Timeスケール・バーに沿って任意の

場所でマウスを左クリックします。Playカーソルは、直ちにクリックした新しいポジションへ移動するでしょう。また、

Timeスケール・バーに沿ってPlayカーソルをドラッグすることもできます。 
  

コンテキスト・メニュー 

Timeスケール・バーの左端（トラック･ヘッダー表示の上）をクリックすると、下図のコンテキスト・メニューが表示さ

れます。 
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最初の5つの項目は、メインのTimeCodeスケール・バーの表示モード（スケール単位）が選択できます： 
z Frames 
z Samples 
z [ms] 
z CD frames 
z Display as CD Time 
矢印がある項目はサブ・メニューが開き、直接Markerの1～10へアクセスできます。 

  
後半の残り３つの項目は、TimeCodeスケール・バーに新しいスケール・バーを追加表示します： 
z Alternate TimeCode Scale 
z Feet Scale 
z Bars & Beats Scale 
 
 

Alternate Timeスケール・バー 

Alternate TimeCode Scale選択すると、メイン・バーの下にもう一つTimeCodeスケール・バーを追加できます。 
 
Alternate Timeスケール・バーは、View > Scales / Toolbars > Alternate TimeCode Scale Settings メニュ

ーを選択するか、表示されているAlternate Timeスケール・バーの左端をクリックしてコンテキスト・メニューから

Alternate TimeCode Scale Settingsを選択することで、スケールの設定が行えます： 
  

z Alternate TimeCode Scale Settings 
 
下図のダイアログが開きます： 
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スケール設定 

Scale SettingのTimeCode Resolutionコンボボックスは、TimeCode表示のスケール解像度を選択できます： 
z Frames 
z Samples 
z [ms] 
z CD Frames 

 
  

Alternate Frame Type for Frame Resolution のコンボボックスは、TimeCode Resolution を“Frames”に設

定した場合に、フレーム・タイプを選択できます。 
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Alternate Frame Type for Frame Resolution を選んだ場合、Stretch Scale to match Main Scale Frames
のチェックボックスはメインの TimeCode スケール・バーと Alternate Time スケール・バーの表示を（1 フレーム＝

1 フレーム）に揃えます。チェックを外した状態では、（1 秒＝1 秒）で揃っています。スケールをストレッチさせて（1
フレーム＝1 フレーム）にした場合、両方のスケール表示は異なりますが、例えば 24 フレームのイベントと 25 フレ

ームのイベントを比較することが可能です。 
  
  

Origin in Main Scale 
Offset 
メインの TimeCode スケール・バーと Alternate Time スケール・バー間で、オフセットをストアすることができます。 
例えば、同じ映像を使用してバージョン違いの音声を作成する際に使用してください。 
 
Store ボタンをクリックして現在のカーソル位置情報から自動計算させるか、Offset タイムを直接タイプ入力して設

定します。 
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Film Feetスケール・バー 

他のスケール・バーと同様、Feetスケール・バーのヘッダー（左端）をクリックするとコンテキスト・メニューが開き、

そこからFeet Settingsダイアログを開くことができます： 

 
Foot Type 
ラジオボタンは、16mm（40 フレーム/フィート）と 35mm（16 フレーム/フィート）を選択できます。 
 
Frame Type 
コンボボックスからフレーム・タイプを選択できます。 
デフォルトは、All Settings > Formats & Sync > Frequenciesで設定されているフォーマット（General 
Settings Format）です。ノンリニア編集の状況によっては、他のフレーム・タイプを要するかもしれません。 
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Bars & Beatsスケール・バー 

他のスケール・バーと同様、Bars & Beatsスケール・バーのヘッダー（左端）をクリックするとコンテキスト・メニュー

が開き、そこからBars & BeatsダイアログとTempo Mapが開けます。Tempo Mapオプションを選択すると、

Bars & Beatsスケール・バーの下に任意のテンポ・マップを表示することができます。 

 
Midi Files Import / Export 
z Load 
z Save 
両方のボタンは、ロードするファイルや保存先のロケーションをナビゲートするブラウザ画面が開きます。 

Note: 一般にタイプ2のMIDIファイルをインポートした時は、トラック1のテンポ・マップとシグネチャーしかインポ

ートしません。 
  

Resolution 
PPQ（Pulses Per Quarter Note）のクロック解像度を設定します。 
コンボボックスから、192～49152までの値を選択できます。 

  
Bars & Beats 

Offset メインのTimeCodeスケールとBars & Beatsスケール間で、オフセットをストアすること

ができます。Storeボタンをクリックして自動計算させるか、Offsetタイムを直接タイプ入

力して設定します。 
Store 現在のカーソル位置情報からOffsetタイムを自動計算して設定します。 

  
Note: オフセットは、ネガティブ/ポジティブに設定できます。 
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Time Signature & Bars 
画面の左下にはソングファイルのオーダーによるバーのブロックがリスト表示されます。  
以下の設定は、リスト内で選択しているバーの設定を行います。 
 

Time Signature コンボボックスを使用してタイム・シグネチャーを設定してください。 
Number of Bars コンボボックスからInfiniteを選択するか、値を直接タイプ入力してください。 
Snap Grid コンボボックスからOffを選択するか、Note～1/64 Noteの間で値を選択してください。

  
 
Add Bars 
クリックすると、リストに新しいバーのブロックが追加されます。 
 
Remove Bars 
リスト内から、任意のバーを削除します。 
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Metronome 
 
Metronome Settings... 

 
Tempo 
画面の右下にはソングファイルのオーダーによるテンポの定義がリスト表示されます。 
以下の設定は、リスト内で選択しているテンポの設定を行います。 

  
BPM ドロップダウン・リストから任意のBPMを選択するか、値を直接タイプ入力してください。

右端の▲/▼ボタンを使用すると、1BPMのステップで増減できます。 
Frames & Perfs フィルム・コンポーザーによって使用されるテンポ定義の代替設定です。 

これは、24フレーム/秒，8perfs，フィルム・パーフォレーションをベースにしています。 
従って、値が24.0の場合に60BPMのテンポになります。 

Perfsは、小数点も入力できますが、誤った値（例：12.7）は修正されます。 

Smoothing コンボボックスからOffを選択するか、Note～1/64 Noteの間で値を選択してください。

Start テンポのスタート・ポイントを入力することができます。 
End テンポのエンド・ポイントを入力することができます。 

  
 定義されているすべてのテンポが表示されます。 
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Add Tempo 
クリックすると、リストに新しいテンポが追加されます。 
 
Remove Tempo 
リスト内から、任意のバーを削除します。 
 

Playカーソルのオプション 

Viewメニューを開くと、Playカーソルに関する４つのオプション・メニューがあります： 

 
Fixed Cursor while playingオプション 
再生中、Playカーソルのポジションを画面上に固定し、タイムラインを移動させます。 
 

Free Cursor while playingオプション 
再生中、Playカーソルがタイムライン上を移動して画面の端へ到達したときに、画面をスクロールせずにタイムラ

インの表示を残します。 
  

Free Cursor while chasingオプション 
Free Cursor while chasingを選択すると、PyramixがチェイスしているTimeCodeマスターの機器がStop / Rew 
/ FF / Play / Locateなどを行っていても、自由にタイムライン表示を移動できます。このモードは、シネマのミックス

時などにPyramixをチェイスさせたまま、現在のTCポジションに関係なく迅速に編集・調整の作業を行うために有

効です。 
  

Free Cursor while chasingを選択していない場合、カーソルは常時TCソースとなるTimeCodeにチェイスしてい

る状態となります。PyramixのPlayカーソルとタイムラインの表示は、常に現在のTCポジションを反映します。 
  

Auto Return after playingオプション 
再生を止めた時に、自動的に Play カーソルを元の位置（再生をスタートしたポイント）へ戻す設定です。 

  
  

Playカーソル・ポジション 

View > Fixed Cursor while playingを選択した場合、Playカーソルが画面で固定されるポジションはSettings 
> All Settings > Application > Playback/Recordページの“Fixed Cursor Settings”の設定で反映されます。

“Place of Cursor in Screen”のコンボボックスから、1/2～1/10の範囲で設定してください。 
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コンポジションの情報とツール・バーの設定 

 
  

Timeスケール・バーの上には、TimeCodeツール・バーがあります。 
 TimeCodeツール・バーには、各TimeCodeに関連する以下のレジスターが並んで表示されています。 

 

   Playカーソル － 現在のポジション 
  

 Mark In 
 

 Mark Out 
 

 Mark In to Mark Out － Mark In/Out範囲の長さ 
 

 Selection In 
  

  Selection Out 
  

  Selection In to Selection Out － Selection In/Out範囲の長さ 
 
上記はすべて、キーボードから直接タイムコードを入力することができます。 

  
Mark In to Mark Out または Selection In to Selection Outの値を変更した際、Outの位置が調整されます。  

  
上記のアイコンをクリックすると、コンポジションのタイムライン表示は以下のように変化します。 
Playカーソルのアイコンをクリックすると、タイムラインは現在のPlayカーソルの位置を中央に表示した状態へ移

動します。同様に、Mark In, Mark Out, Selection In, Selection Outのアイコンをクリックすると、各マーカーの

現在のポジションを中央に表示した状態へ移動します。 
 
また、Mark In to Mark Out, Selection In to Selection Outのアイコンをクリックすると、各エリアを画面いっぱ

いにズームして表示します。 



トランスポート&ナビゲーション：マーカー 
 

Pyramix ユーザーマニュアル  

マーカー 

Pyramixには様々な種類のマーカーがあり、登録したマーカーはトラック表示の上のマーカー・トラックに表示され

ます。そのうち、CDおよびSACDマーカーについては、23章“CD/SACDマスタリング：CDマーカー”のページを参

照してください。 
 

 
 
マーカーの機能は、Cursor & Markersメニュー，ツール・バー，ショートカットから利用することができます。 
Cursor & Markersメニューの内容については、24章“メニュー：Cursors & Marks”のページを参照してくださ

い。 
 

Markersタブ画面 

マーカーは、Markersタブ画面から追加・削除などの管理やロケートを行うことができます。 
 

 
  

最大48個までのマーカーが、ショートカットやコントローラーにアサインできます。Markersタブ画面内のProject 
Markersまたは任意のTrack Groupを指定することで、マーカー・リストの表示を切り替えて編集できます。 
マーカーはタイムラインの時間に従って昇順に付番されます。マーカーを他のマーカーの前後へ移動した場合は、

関連するマーカーの番号が自動的に変更されます。 
  

新しいマーカーを追加するには、1行目のフィールドにある‘Click here to add a new Marker’をクリックして、マ

ークの名前を入力します。追加されたマーカーは、00:00:00:00で登録されるので、Timeフィールドを使って値を

編集してください。 
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マーカーの色はユーザー指定できます。Colorフィールドのドロップダウン・リストから色を選んでください。 

  
マーカーの名前が表示されているフィールドをダブルクリックすると、Playカーソルがマーカーの位置へジャンプし

ます。 
  

Ctrlキーを押しながらをダブルクリックすると、マーカーのTimeCodeから再生します。 
  

Shiftキーを押しながらをダブルクリックすると、マーカーのTimeCodeからプリロール再生します。 
 
また、リスト内のマーカーを右クリックすると、マーカーのCut / Copy / Pasteが行えます。 

  
  

マーカーのリンク 
Markersタブ画面内の一番上にMarkers Linkingのドロップダウン・リストがあります。 

 
 
ここでは、トラックを編集した場合にマーカーをどのように連動させるかを設定します。 

  
Markers Independent  マーカーはTimeスケールにロックします。 
Linked to Any Track  マーカーはトラックとリンクします。 
Linked to Tracks without Group マーカーはグループに属していないトラックとリンクします。 
Linked to ‘Effects’, ‘Music’, ‘Foley’ マーカーはリスト内の指定したTrackグループとリンクします。 

 



トランスポート&ナビゲーション： Jog & Shuttle 
 

Pyramix ユーザーマニュアル  

Jog & Shuttle 

マウスのホイールを使ったスクラブ 
Timeスケール・エリアにおいて、Playカーソルをマウスのホイールで掴んで前後へ動かすとオーディオをスクラブ

することができます。スクラブの再生スピードは、画面のズームの状況で相対的に変化します。マウスのホイール

を離すとスクラブ動作は停止します。 
 

Shuttle 
最大８倍速のスピードでオーディオを出力しながらシャトルできます。 
 

Jogの設定 

Jog / Scrubのパラメーターは、Settings > All Settings > Application > Jog / Chaseページで行います。 
  

Auto Jog on move 
フィジカル・コントローラーのJog / Shuttleホイールを使用する場合にチェックしておくと、Jogホイールを回したこと

を感知して自動的にJogモードになります。 
  

Auto-Solo Selection 
Jogモードの際、自動的に選択したトラックをSoloにします。 

  
Speed ceiling 
4つのラジオボタンで、JOGの最大スピードを 1X，2X，4X，8X から選べます。 
 
Sensitivity 
フィジカル・コントローラーのJog / Shuttleホイールを1回転させた時に何second（秒）動かすかを値で入力します。 

  
Smoothing Filter 
Jogの開始と終了時のフェードイン/アウトの長さをビデオ・フレームで入力します。 
値を大きくすると、Jogを回した時に再生される音はスムーズになりますが、Jogの反応速度は遅く感じられます。 

  
Flywheel Inertia 
スライダーをhighに設定すると、Smoothing Filterの設定を反映してJogが動作します。 
lowに設定すると、Smoothing Filterのパラメーターは無効となり、Jogホイールから実際に送られる動作に追従し

ます。ポストプロダクションなどの用途ではビデオとのタイトなシンクが必要となるため、low方向に調整します。 
まずは、中間の位置からスライダーの設定を開始してみてください。 

  
Transient response accelerator 
Jog動作への反応を、オーディオを可能な限り滑らかにする（smooth）と、ポジションを正確に示す（accurate）の間で最

適化するパラメーターです。スライダーをAccurateに近づけ過ぎると、予期せぬ効果が起こるかもしれません。 
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Mouse Scrubbing Settings 
Analog Tape ModeとRepeat Loop Modeの2つのスクラブ・モードがあります。ラジオボタンで設定したいモード

の方をクリックしてください。Repeat Loop Modeに設定した場合、ループの長さはベースサンプリング周波数に

関連してきます。44.1，88.2，176.4kHzでは116ms、48，96，192kHzでは106msとなります。 
 
Limit to speed ceilingを選択すると、マウス・スクラブはJog SettingsセクションのSpeed Ceilingの設定に制

限されます。 
  

Silent locateを選択すると、Jogまたはスクラブをした時にオーディオは出力されません。 
 

Scrub Settings 
Audio Quality 
2つのラジオボタンで、スクラブした時のオーディオの質を選択できます。デフォルト設定はImprovedです。 
スクラブを高音質で行おうとするとプロセッサーに負担がかかる為、ImprovedモードにはMax simultaneous 
tracksの値を予め入力しておくボックスがあります。デフォルト設定は6です。同時再生するトラック数が指定した

数より多くなった場合は、自動的にStandardモードに切り替わって動作します。 
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Transportコントロール 

Transportバーには、一般的に使われるトランスポート操作，チェイス，キャプチャー・オフセット，カウンターおよ

びトランスポートのステータス表示などが備わっています。 
 

 
  

カウンターは、現在のActiveマシーンの位置とTransportモードを示しています。 
 
各コントロール表示の内容は、以下のとおりです： 
 

 
カウンターはRecordモードを示しています 

 
Rewindボタンは、Activeマシーンを巻き戻します。 
2回押すと、ダブル・スピードになります。 

 
ActiveマシーンがInternal Machine（Pyramix）の時に、Play Selectionボタ

ンは、現在選択しているエリアを再生します。 

 
Playボタンは、ActiveマシーンをPlayモードにします。 

 Recordボタンは、ActiveマシーンをRecordモードにします。 

 
Fast Forwardボタンは、Activeマシーンを早送りします。 
2回押すと、ダブル・スピードになります。 

 
再生を停止するStopボタン 
（Pause機能は、Machines > Active Machine > Pauseメニューにあります） 

 
Loopボタンは、Activeマシーンをループ再生モードにします。 
任意のMark In/Outポイントの区間を、繰り返し再生します。 

 
Shuttleコントロール・スライダーは、Playスピードの最大2倍速でPlayヘッドを

前後にスライドできます。トラック上のクリップをスクラブ再生します。 

 
ドロップダウン・リストから制御するマシーンを選択できます。 
Internalを選択すると、Pyramixを外部デバイスから切り離して直接コントロー

ルが行えます。 
その他のマシーンの設定は、Settings > All Settings > Remote Control > 
Machineから行えます。（例：RS-422 Sony 9ピン P2制御のマシーン） 

 
Chaseトグル・ボタンをアクティブにすると、TCポートのTimeCode入力に追従

して再生ます。 

 
外部コントローラーのOnline / Offlineを切り替えるトグル・ボタンです。 
（緑＝Online，赤＝Offline）  

  
Transportバーの右隣には、デフォルトでAutomationツール・バーが並んでいます。 
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Transportコントロール・パネル 

 

 
Transportコントロール・パネルのボタン押すと、下図のTransport画面が開

きます。（または[Alt+T]，View > Windows / Tools > Transportメニュー） 
Transport画面には、利用可能なマシーンのステータスやコントロールが個

別に示されます。 
 

 
  

Note: このパネルでは、Internalトランスポート（Pyramix）をはじめ、設定されているデバイス毎にTransportコ
ントロールが表示されます。その下には、LTCおよびVT（VITC）のTimeCodeソースのステータス表示と外部コ

ントローラーに関するコントロールが表示されています。黒い名前の部分をクリックすると、各表示をコンパクト

に折り畳むことができます。例えば、上図のdvcamは、コンパクトに折り畳まれている状態です。 
  

重要! : マシーンの設定に関する詳細は、26章のSettingsの章で“Machine”のページを参照してください。 
また、それらのTransportコントロールに関する詳細は、20章のMachineコントロールの章で“Internal / 
External Machineパネル”のページを参照してください。 

  



トランスポート&ナビゲーション：ズーム&パン 
 

Pyramix ユーザーマニュアル  

ズーム＆パン 

プロジェクトの編集パネルでは、水平方向にタイムスケールをズームする方法と、垂直方向にトラックの高さをズ

ームする方法の2通りがあります。 
 

Timeスケールのズーム＆パン  

Viewツールバーのアイコンは、現在のPlayカーソルを軸にしたズーム・イン/アウトを行います。 
 

 
Fit in window [Alt+1]アイコンは、選択したエリアを編集パネルの幅いっぱ

いにズームしてフィットさせます。 

 
Previous zoom [Alt+2]アイコンは、一つ前のズーム・サイズに戻します。

（水平方向のみ） 

 ズーム・イン [Alt+3] 

 ズーム・アウト [Alt+4] 

 
Altキーを押しながらマウスのクリック＆ドラッグでコンポジションのエリアを選択すると、マウスカーソルが虫眼鏡

アイコンに切り替わり、選択したエリアを編集パネルの幅いっぱいにズームしてフィットさせます。 
  

マウスのクリック＆ドラッグでは、コンポジションのエリアを選択することができます。 
 
トラック表示の下にあるスクロール・バーは、トラックの表示を左右に移動することができます。 
 

Trackスケールのズーム 

 
 
トラック表示の左下には、1, 2, 4, 8, 16 および A ボタンがあります。 
各ボタンを押すと、トラックを自動的に垂直方向へズスケーリングして、編集パネルの範囲にトラック表示をフィット

させて表示します。 
  
 ボタンの脇にあるスクロール・バーは、トラックの高さを微調整することができます。 

 
 

スクロール・ホイール 

マウスのホイールを使うと以下の操作が行えます。 
 
z Scroll   トラックの表示を垂直方向へ移動します。 
z Scroll + Ctrl  タイムラインの表示を水平方向へ移動します。 
z Scroll + Alt   タイムラインのスケールを水平方向へズームします。 
 



トランスポート&ナビゲーション：Overviewタブ画面 
 

Pyramix ユーザーマニュアル  

Overviewタブ画面 

 
 
Overviewタブ画面は、プロジェクトの編集パネルを強力かつシンプルにナビゲートします。 

  
Overviewの表示は、すべてのクリップの位置を表示して、コンポジション内の全体の概観をグラフィック表示しま

す。上図で影のように表示されているグレー色のボックスは、現在編集パネルに表示されているコンポジションの

位置とズーム範囲を示しています。クリップは、タイムライン上で指定されているクリップの背景色と同じ色で表示

されます。 
 
Overviewのどこかをクリックすると、その位置が中心となって編集パネルに表示されます。 
影のように表示されているグレー色のボックスをクリック＆ドラッグすると、ズーム範囲を保ったままでコンポジショ

ンの表示を前後に移動できます。ズーム範囲を変更したい場合は、Overviewタブ内でグレー色のボックスの端を

ドラッグすることで範囲が調整できます。 
 
また、Altキーを押しながらクリック＆ドラッグすると、コンポジションの位置とズーム範囲を指定して編集パネルに

表示させることができます。 
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